Using Visual Studio.NET
Introduction
This document outlines how to compile and link code using Visual Studio.NET 2005 on a Windows machine. However the functions that are described should be the same for 2003 version.
Vocabulary

1. A “Project” is an entity that can be built, a program, a static library, a dynamic library.

2. A “Solution” in visual studio is a collection of projects. 

For examples, the programs and libraries from the suite are projects and the overall suite would be a solution.
Creating a new Solution / new Project
Start Visual Studio, do not open an existing solution. Go to the “File” menu and click “New…”, then choose “New Project”. Then you should see this window:
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 On the left you can choose the type of project, we only use Visual C++ (General) and Intel® Fortran (Console Application, Static library or Dynamic link library) in our cases. On the right you can choose the template of project, it is recommended to always choose an empty project to start with, to make sure that the advanced options (that we never use) are not tweaked weirdly. At the bottom you can specify the solution name. This will change the “Location” value. You then can specify the name of the project. By default the “Location” should be 

\Documents and Settings\<your username>\My Documents\Visual Studio Projects\<sln_name>\
The project name is then a subdirectory of this directory.

Adding Projects in the solution
Once you have your solution open, on the right hand side you should have the “Solution Explorer” looking something like this:
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Adding Files
Similarly, a right lick on the directory of your choice (“header files” or “sources files” mainly) gives you the choice to add a new file or an existing file. If you add header files in the source files item it is not really a problem as they won’t be compiled because they are recognized as header files from their file extension.
The Project Properties
When you right click on a project name and choose properties you get the following window: 
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The window comes up with the general configuration properties at the top. Then you have a C/C++ (or Fortran) properties with a list of parameters related to the C/C++ language and finally a Linker (or Librarian) set of properties related to the linking options. The first key parameter to set is the one outlined on the right, “Configuration type”. This is by default set to “Application”, however you can change it to Static Library (the Linker part then changes into Librarian), or into a Dynamic library (dll). All the rest can be left as default. 
C/C++ key properties
There are a lot of options, however most of the time only a few of these are used. Below is another screenshot of the C/C++ properties area.
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Circled in green are the properties used the most often. The first one “General” is mainly used to specify the include directories. You can either type the whole path to the directories by hand, separated by semi-colons, or you can click on the button that appears at the right hand of the field to see the directories as a list. Clicking on any item in the list will let you navigate to find the correct directory.

In the Optimization area, the top level option lets you choose between “program size” (-O1) speed (-O2),  and “speed plus higher levels” (-O3). 

In the Preprocessor area, the top field lets you define all of the pre-processor words required for this project, each word has to be separated with a semi-colon. By default WIN32 and NDEBUG are already there.

Usually, the rest can be left as it is. Note that if you right click on a file name and choose “Properties” you will be able to override the properties set for the project for that particular file. For example, if a dodgy file needs to be without optimization you can switch it off for that particular file only.

On Visual Studio 2003 you might need to make sure that in “Code Generation” the “Runtime library” is the same between all projects.
Fortran key properties

For the Fortran projects the properties section looks like this:
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The key sections are also circled in green.

The “General” Section summarizes the most important options, which in theory means that you can deal with optimization there as well.

In the “Optimization” section, in addition to the level of optimization, you also can choose the family of processor you want to optimize for. It is usually better to set it to blended as it should do some fair optimization that would work across all x86 processors.

The “External Procedure” section lets you specify which calling convention you want. The people who wrote Fortran interfaces for C/C++ libraries know what it is all about. You have to make sure that the section “Calling Convention” is set to C, REFERENCE, and that the section “Name case Interpretation” is set to Upper Case.
The “Run-Time” section contains a set of checks that can or can not be performed, the main useful one is “Array and String bound”. This will force the program to stop if an attempt to reference an index out of bounds is detected.
Linker key properties

On the next page is a screenshot of the linker properties sections. The most interesting sections have again been circled in green.

The most important point in the “General” section is to tell where to put the built executable (or dll library). It is a good idea to keep the project name the same as the executable it will produce so that the $projectName variable can stay, but you can change it if you like or need to. For example, the executables in the ccp4 build would be 

\CCP4-Packages-source\ccp4\ccp4bin\$(ProjectName).exe
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In the “Manifest File” section I switch the creation of a manifest file off, because I do not know what it is used for and it creates extra files in the output directory, making it a mess.
Similarly, in the Debugging section I turn off the debugging to avoid having a .pdb (program debugging) file being created.

The important point in the “Advanced” section is the “Target Machine” section. You just need to make sure it is set to Machine X86, it will still work if you do not, but I think it makes the executables quicker and more robust.
Librarian key properties
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For the library properties there is only one useful thing to set. It is the location of the compiled library file.

Project Dependencies
Before being able to build an executable, you need to specify its dependencies. In practice if you are not sure what it depends on, you can firstly try to build the executable and then look at the linking problems to see which library it needs. Anyway, if you do know in advance which dependencies a project needs (executable or dynamic library, static library do not depend on anything), you can right click on the project name and choose “Project Dependencies”. You will get a window like this one:
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The main window
So far we only needed to use the right-hand part which is the solution explorer. From now on we are going to use more of the other parts so let’s describe it quickly.
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The solution explorer area is the one we have been using so there is nothing more to add. When you double click on one of the files in one of the projects it is loaded in the editing zone where you can do whatever you want with it in the same way as you would edit text in a text editor.

The Reporting Area is where all the compilation and linking warnings and / or errors will be displayed.

Building
We are now ready to compile the code. You can do this at various levels. When you right-click on a file you have the option to compile it. If you right-click on a project, in the menu you have 3 key entries: Build, Clean, Rebuild. Build will compile all the files that need compiling in your project. If any dependent project was not already built, they will be built first and then your project will be built. If it is the first time you build a project than all the files will be compiled. If it is not the first time, then normally only the files that have been modified since the last build will be recompiled. 

However, if you want everything to be recompiled, you can choose the “Rebuild” option. The rebuild is basically performing a cleaning operation followed by a build operation.

The “Clean” option deletes all compiled files (aka the object files).
It is important to know that these three operations will affect not only the project itself but all the projects it depends on. This means that a clean or rebuild will be performed on any projects related to the one you are working on. If you do not want this to happen, right-clicking on the project name will give an option called “Project Only”. It has a submenu which also has build, clean and rebuild entries. These do what they say on the tin.
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Once you click on Build, the reporting area starts to be filled up by all the compilation information of each file. If you double click on any compilation warning or error, the corresponding file will be loaded in the editing zone and it will point to the line causing the warning or error. This makes it very quick to go and fix problems.  
You also can build at the solution level. If you right-click on the solution name, you will have the choice to build, clean or rebuild the whole solution. When building the solution, only the projects that are not up to date will be built. Beware that it might take some time if you do a rebuild on the whole CCP4 suite for example.
More Advanced stuff
 This section is about, other things that you probably need to know even if you might not use it. 
1) Lapack-blas dependency: intel provide compilers but also a math library called the “Math Kernel Library” (aka MKL) which contains various math libraries and in particular, lapack, blas and also scalapack. There are two ways to include these libraries if the project needs them (scala and refmac need them for example).

First, you can right click on the section “Resource Files” choose “Add Existing Item”, then navigate down to the directory where the MKL is installed and add mkl_c.lib and libguide.lib. The first once is a Fortran static library with C Reference calling convention and the second one is needed by the first one to get the information about handling threads.

Alternatively, in Visual Studio you can click on the “Tools” Menu at the top, then click “Options”. A window pops up. In the left part of the window select “Intel Fortran”->Compilers, then on the right part of the window, click on the “…” button beside the libraries field. In the list that pops up, add the directory in which the MKL libraries are. Then you need to add the same directory for the C/C++. To do so, on the left, choose “Projects and Solutions”->”VC++ Directories”. Then on the right part at the top, in the drop down menu choose “Library File”. A similar list of directories is then displayed below, just add the same directory there. Afterwards all you need to do for the projects is to add mkl_c.lib and libguide.lib in the item “Additional Dependencies” situated under the “Input” category in the Linker options.
2) The “Configuration Manager”: this is in the menu you get by right-clicking on the solution name. 
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On the right you can select which project you want to build and unselect the one you want to skip. In the top left corner you can choose between making the whole solution configuration a ‘Release’ type or a ‘Debug’ type. In the top right corner you can choose between making the target platform 32 bits (Win32) or 64 bits (x64) for the whole solution (NB: only with .Net 2005, with 2003 you only have 32 bits). This will change the active mode of all the projects accordingly. The properties between modes are kept separately. 
You have to be careful when using this because what is called a “configuration” for a project is the set of all properties (the one I described in the above sections). Each configuration (Debug, Release) keeps its own values for all the properties. This means that when you switch from one to another you might have to set some values again. This is particular true for .NET 2003. With .NET 2005, you will be asked if you want to copy across the “configuration” when you switch between modes. You can always access the properties for the different modes. On the previous properties screenshot in the previous sections, if you look at the top you will see a drop down menu that lets you switch between modes to view and set properties. The current mode is annotated with “Active” so that you know which configuration will be taken into account at build time.

Using the Visual Studio Debugger

There are two approaches to doing this, running test from Visual Studio itself or debugging on demand. I usually do the later one, but that is just personal preference. If you want to run tests from visual studio, just go to the project properties and choose the “Debugging” option under the “General” section. You can then specify the command, command arguments and all the bits that you need to run an example, including the environment variables (Joy!).

The other approach, “on-demand”, is usually when a program crashes. When you have visual studio installed and the executable you are running has debug information (see C/C++ properties, General, Debug Information Format), then a window will pop-up asking you which debugger you want to use (there is only visual studio usually). Once you choose it, it will start visual studio up and probably give you information about some unhandled exception occurring at some point. Then you might have something looking like this:

[image: image12.jpg]Solution Explorer - pri... » & X

[ solton printpesks' (1 projec

T prinpeaks.ene

< >
Y Soluion Expl.. (33 Closs Vi
utos

Hame value

@ _debugger_hool 0

‘dbghook.ca

int _cdesl CrDefaultillocHook(
int nhllocType,
wvoid * pvData,
size_t nSize,
int nBlockUse,
long lRequest,
const unsigned char * szFileNane,
int nline

)

endif /* DEBUG +/
£ int _debugger_hook_durny;
L

E#ifdes _M_Thed
Hundef _CRT_DEBUGGER_HOOK

fendif /v W Iasa o/
__declspec (noinline)
¢

(_Reserved) ;

R ERR TR R AT IR AR AT AR AR AR AR AR TR AR TR AR AR R AR R AR AR R AR AT T IR RRR]

return 1; /* allov all allocs/reallocs/frees ¥/

| #aesine” CRT DEBUGGER_HOOK _crt_debugger_haok

E1void _cdecl _CRT DEBUGGER HOOK[int _Reserved)

/% assign O to _debugger_hook_dwmiy So that the function is not folded in retail +/

|| _aevugger_ncox_awmy = o;
)

@ 3
~ B X [calstock -1
Type Name Lang

int = printpeaks.exel_ct_debugger_hook(int _Reserved=) Line 65 c
printpeaks.ve! invake_watson(const wchar_t * ps2Expression=0+00000000, const wehar t: * pszFunction=0<00000000, const u C-++

printpeaks.exe! lose(int i=3) Line 47 + x2a bytes c
pintpeaks.ere!DI: Dffractinliager osdRanimage(std: basc_string<char,stcichar_raits<char,std: alosator <char> > lena C-++
printpeaks.xeIDI: DFfractioninager oadDSC() Line 127 s
printpeoks.cxe!DI: Difractioniage: foad() Line 272 s

printpeaks.exeDL

Difractionimage: dosd(char * Fiehiame

00563be7) Line 260 + 048 bytes chr





On the left (or right) you have the solution explorer, not relevant in this case, you still have the large edition pane loaded to where the problem was identified. On the bottom you have the calling stack (the bit on the bottom left will show you variable values but it might only be with 2005). At the top of the calling stack you very often have some calls that come from windows libraries. The interesting point is when you find the first call in the stack that is related to the program itself, this is usually the guilty bast… Double click on it and it will load up the source file related to the failure at the exact line of code where it occurred (That is REALLY useful !!). Then all you need to do is explore around in the variable value (right-click on the variable name and choose quick-watch) and find what is wrong.
Some portability goodies

This is just a list of things to know when compiling code on windows for the first time. It is about what to avoid, how to find equivalent and so on…

· <unistd.h> is unix specific and will always cause compilation error, most of what is defined in it is usually available with stdlib.h which is preferred. However if unistd.h is really needed for Unix system then you have to wrap it like this.

#ifndef _MSC_VER

#include <unistd.h>

#endif

This wrapping method is to be used with anything that is Unix specific.
· To have access to the getpid() method you need to include process.h
· atanh is not defined with the math.h that comes with Visual C/C++. You will need to define it by hand (#define atanh(x) 0.5*log((1+x)/(1-x));). Furthermore, if you need to use constant defined in math.h you need to add a preprocessor _USE_MATH_DEFINES
· The windows C compiler is picky, any missing return value will not be automatically guessed, any unclear use of floats and doubles in a math function can confuse it so be clear about what you are using.

· The DIR structure does not exist on windows, if the code is using it, it will not compile. (for example: pisa)

· Sockets are defined with Winsock2.h (or Winsock.h but the other one is better).

· If you dig into .NET 2003 help, there is a lot of useful information about porting from Unix to win32. Go to “Help”, “Contents”, then on the right expand “MSDN library”, within the list appearing expand “Windows Development”, then in the list under expand “unix Migration”. You should then have the Unix Code Migration Guide, the most interesting chapter is chapter 9 but you also can read the rest.
· If you have a Makefile.am use it as the guideline to create your project, firstly look at the source files indicated, then anything in the CFLAGS or CXXFLAGS should be available in the C/C++ properties area. Then look at the LDFLAGS, this will tell you the dependencies for the project and any flags there should correspond to some option in the Linker properties area.

· For an example of common things that need to be done during porting see the notes on how to compile pdb-extract on windows, logged in bug #1268
· The following programs are known not to compile or are untested properly on windows: Pisa (because of the DIR struct), pdb-extract (because tests on a built executable looked unsatisfactory), mosflm (because of x-library thing, harry can provide a clean version though) and all the x-windows programs
By doing a right click on the solution name or icon, you should have a menu in which you can choose “Add” -> “New Project” or “Existing Project”. If you choose the first option, you will be presented with the same window as before. If you choose the second option then you will have to choose the “.vcproj” file you want to add. The icon for the file type is the same as in the solution explorer.
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All you need to do is tick the boxes of the libraries your project need.
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